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Abstract: The aim of this community service is to provide IT-based English language learning 
media training using Mcrosoft PowerPoint and learning videos. This dedication was given to 
PAUD Teachers in the Buntu Pane District. The dedication session consisted of distributing ma-
terial to participants, stages of making Microsoft PowerPoint, and making simple videos. The 
model used is the training model, delivering material, question and answer session, and direct 
practice. In general, participants claimed that the training schedule was appropriate, time was 
shared (delivering material, demonstrations, questions and answers, and direct practice). The 
participants of the activity were satisfied with the topic presented and felt that most of the ex-
pectations and objectives of the service had been fulfilled. The evaluation results showed that 
the material presented could be well followed. 
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Abstrak: Tujuan dari pengabdian masyarakat ini adalah memberikan pelatihan media 
pembelajaran bahasa inggris berbasis IT menggunakan Mcrosoft PowerPoint dan video 
pembelajaran. Pengabdian ini diberikan kepada Guru Guru PAUD Se-Kecamatan Buntu Pane. 
Sesi Pengabdian terdiri dari membagikan materi kepada peserta, tahapan-tahapan membuat 
Microsoft PowerPoint, dan membuat video sederhana. Model yang digunakan adalah model 
pelatihan, menyampaikan materi, sesi tanya jawab, dan praktek langsung. Secara umum, peserta 
mengklaim bahwa jadwal pelatihan sudah tepat, pembagian waktu ( menyampaikan materi, 
demonstrasi, tanya jawab, dan praktek langsung). Peserta kegiatan puas dengan topik yang 
disajikan dan merasa bahwa sebagian besar harapan dan tujuan pengabdian sudah terpenuhi. 
Hasil evaluasi menunjukkan bahwa materi yang disampaikan dapat diikuti dengan baik. 

 
Kata kunci: bahasa inggris; microsoft powerpoint; guru guru paud 

 

 
 
 

INTRODUCTION  
 

English as an international language, 
gets more attention in the world of education 
in Indonesia, especially at an early age, 

children easily obtain or learn something 
new in learning languages. Learning English 

that is done continuously and using 
appropriate learning methods, can bring 
benefits, among others, they will be 

intellectually stimulated, children will 
more quickly understand the material 

presented. Many ways and techniques 
of learning in English that are done by 
English teachers are not suitable for 

the age of the children, by teaching 
English to children using the word-for-

word translation method. This method 
will make children bored and not 
interested in learning English. By 
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introducing learning methods using 

Microsoft PowerPoint and learning videos 
will make it easier for PAUD teachers at 
Buntu Pane sub-district to conduct teaching 

and learning activities in class.  Hamrlik 
argues that the use of instructional media in 

the teaching and learning process can arouse 
desire and interest as well as motivation and 
stimulation of learning activities (Nuriani, 

Somantri, and Sutrisn, 2019).  Microsoft 
PowerPoint is a popular and most used 

presentation application program today for 
various purposes of presentation in the 
learning process. PowerPoint is becoming a 

preferred method of communicating, pre-
senting, and sharing knowledge (Adams 

2006). It is suggested PowerPoint supports a 
cognitive and pedagogical style inconsistent 
with both the development of higher analyti-

cal thinking skills and the acquisition of rich 
narrative and interpretive understanding. 

PAUD / IGRA Buntu Pane teachers are 
almost average in their learning but still do 
not utilize the information technology 

sophistication. specifically in IT-based 
learning. Every teacher should at least have 

the ability to make teaching materials in the 
form of PowerPoint. PowerPoint provide 
many facilities that are great enough to 

make teaching media.  PowerPoints can be 
optimized properly to create teaching media 

packages.  Seeing the not yet maximum use 
of information technology of the Teachers 
(Anggraeni, 2019), especially in IT-based 

learning methods in supporting learning 
objectives, the Community Service team 

developed a strategy to conduct "IT-Based 
English Training for Early Childhood 
Teachers in Buntu Pane District" which was 

carried out in Athfal (RA) Al-Fariq Sei Silau 
Timur Village Hamlet II-A Buntu Pane, 

Kabupaten Asahan. 
 
 

 
 

METHOD 

 
In this activity the Principal of 

RA Al-Fariq provided a place during 

the activity and the supporting 
facilities they had to support this 

activity went well and smoothly. After 
the Community Service activities are 
carried out, the next step is the 

community service team conducts 
monitoring for 3 to 5 times at RA-Al-

Fariq, to ensure that they are truly able 
to make teaching materials using 
power points and learning videos in 

the classroom as a whole. maximum or 
not yet. If not, the Team will help 

remind you again. This review is 
carried out once a week after the 
activity. Stages or steps taken to be 

carried out properly and smoothly as 
well as the achievement of the 

objectives of Community Service 
activities are: 
1. Prepare material to be given, both 

modules, presentation slides, and 
other teaching aids. 

2. Ensuring that supporting facilities 
and places such as in focus, 
projector, and others are on 

standby when the activity will take 
place. 

3. Before the activity is carried out 
participants participating in this 
activity must already have a 

computer or laptop as a practical 
tool. 

4. Explain theories about IT-based 
English learning media 

5. Practice directly on a computer or 

laptop in making PowerPoint, 
learning videos for teaching 

materials in class. 
6. Discussing cases related to video 

making. 

7. Discussion and question and 
answer. 
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DISCUSSION 

 

In connection with the theme of the 
activity, the materials that have been taught 

and practiced are as follows: 
 

Understanding Microsoft PowerPoint 

2010. 

Microsoft PowerPoint 2010 is basi-

cally the same as Microsoft PowerPoint 
2007. Its function is still to make presenta-

tions. The difference, in Microsoft Power-
Point 2010 is the addition of Menu Transi-
tions, for the replacement of one slide with 

the next slide. This menu in PowerPoint 
2007 is still united in the Animations Menu. 

Another difference, in the Animatins Menu 
it looks simpler by directly showing animat-
ed menus in the menu bar. Microsoft 

PowerPoint  is software for making presen-
tations. If Microsoft Word is used to create a 

written report and Microsoft Excel to create 
a report that involves numeric and graphic 
data, PowerPoint is used to present the final 

result. 
 

Function of Microsoft PowerPoint 
is used for presentation, teaching, or 

simple animation needs. However, there are 

several advantages and benefits possessed 
by Power Point to support its roles and func-

tions, including: 
1) Power Point makes it easy for users au-

dio, video, images / photos, to anima-

tion. This makes the presentation more 
lively and interesting. 

2) Slides can be adjusted and printed. 
3) Presentations can be accessed via any 

computer, with notes connected to the 

cloud or using USB storage. 
 

Strengths and Weaknesses of Microsoft 

PowerPoint  

As a product, PowerPoint also has 

advantages and disadvantages. Where Mi-
crosoft always tries to cover up the deficien-

cies that appear in the latest released 

versions. Well, what are the ad-
vantages and disadvantages of Power-
Point? Advantages  of Microsoft Pow-

erPoint(Panchal 2014) 
1) You can prepare slides at home. 

2) It is possible to retain eye contact 
with your audience during the 
presentation.  

3) It is possible to reproduce very 
complex drawings, sounds, pic-

tures, and even clips in your 
presentation. 

4) It is possible to „build-up‟ an ar-

gument; by showing one sentence 
after another. 

5) Students can receive the slides in 
advance and use them in their 
presentation for attending the lec-

ture. 
6) Presentations are easier to custom-

ize for each audience: It is relative-
ly simple to add, change or delete 
slides.  

7) Looks very professional It is pos-
sible to use colors to add to the 

content. 
8) Graphical presentation is often an 

excellent complement to an oral 

presentation 
 

Disadvantages of PowerPoint 

Presentations  

While PowerPoint can offer 

many benefits for personal, education-
al, or professional use, keep in mind 

these disadvantages of PowerPoint 
presentations: 
• May not always engage users:  

Although you can make engaging 
PowerPoint presentations that use 

multimedia effectively, not all 
presentations end up that way. 
Sometimes, the presentations hin-

der learning when the slides con-
tain distracting elements or con-
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tain only text and narration that viewers 

tune out. 
• Technical issues: Using PowerPoint can 

create some headaches when you face 

compatibility issues, corrupted files or 
internet problems. For example, Mi-

crosoft included a compatibility mode in 
the program to open older files, but 
some elements might not work correct-

ly. You might also face hard drive prob-
lems that cause you to lose your presen-

tation file if you haven't backed it up, 
and internet outages make it impossible 
for users to see your presentation when 

you share it online.  
• Potential cost: While Microsoft offers a 

free basic version of PowerPoint online, 
you likely need to pay for an annual 
subscription if you want to use the desk-

top and mobile apps and gain access to 
all features. The price depends on 

whether you need a home or office ver-
sion of Microsoft Office and how many 
users you have.  

• Lack of flexibility during slideshow 

presentations: Once you start a slide 

show, you can't easily make changes or 
annotate any slides during the presenta-
tion. Instead, you control moving 

through slides or ending the presenta-
tion. So, you need to ensure your 

presentation is ready to go beforehand. 
 
 Activate Microsoft PowerPoint 2010 

To be clearer, for those who are new to Mi-
crosoft Powerpoint just follow the steps to 

make a presentation at Microsoft Power-
Point 2010 below: 
1) Enter the Microsoft Powerpint 2010 ap-

plication by clicking on the Powerpoint 
icon on the desktop screen. If the desk-

top does not have a Powerpoint icon, 
open it by clicking start, clicking all ap-
plications then search for Microsoft Of-

fice by scrolling down the navigation 
(Windows 10). 

 

Picture 1.Display activates 

Mcrosoft PowerPoint 2010 
 

2) Click the arrow to the right of Mi-
crosoft Office posts and look for 
the Powerpoint icon. Then click 

on Microsoft PowerPoint once. 
The Microsoft PowerPoint win-

dow will open. (If you are using 
Windows 7, how to click start, 
click all programs, search Mi-

crosoft Office after you find it, 
click the Microsoft Office folder 

so that several applications will 
appear that are part of the MS Of-
fice. Click Microsoft Powerpoint. 

 

 

Picture 2. PowerPoint Icon Dis-

play 
3) Then the PowerPoint application 

will run. The following interface 
(interface) on Power point. The 
description of features according 

to sequence number is as follows: 
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Picture 3. PowerPoint 2010 Interface 

 

1. Office Button collection of presenta-

tion file management menus 
Tabs on the presentation compilation 
menu. Home tab to edit the contents 

of the presentation slide Insert tab to 
insert objects on the presentation 

slide. Design tab to set the basic de-
sign of the presentation slides. Ani-
mation tab to adjust the display ef-

fect of the slide presentation anima-
tion. Slide Show tab to arrange the 

presentation 
Review tab to check the contents of 
the presentation slides. View tab to 

adjust the presentation window of 
the presentation slide. 

2. The Tab Group in each tab menu 
contains commonly used command 
buttons. 

3. Slides the presentation slides 
4. Slide the first page view of the  

presentation slide. 
5. Title where the author of the presen-

tation title. 

6. Subtitles where the sub-headings of 
the presentation title are written. 

7. Slide Show displays only the select-
ed slide. 

8. Ribbon collection of toolbar menus. 

9. Open   a  New Document To open a 
new document, the steps taken are as 

follows: 

- click the File menu 

- then click the New sub menu 
 

 
Picture 4. PowerPoint 2010 Interface 

 
- then the display will change to a new 

document that is still blank. 
 

 
Picture 5. powerPoint 2010 Interface 

             

 

4) Parts of Microsoft PowerPoint 
Like a program, Power Point also 
has parts that can not be separated 

from it. Following are the Mi-
crosoft Power Point sections and 

their full explanation. 
 

 
Picture 6. Microsoft PowerPoint Parts 

 
Office Office Button Office 

buttons are buttons used to access 
basic commands related to documents. 
For example creating, opening, saving, 

printing, and so forth.  
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 Quick   Access  Toolbar  Quick Access 

Toolbar are icons that are used to ac-
cess user commands quickly. By de-

fault, there are three icons - Save, Un-
do, Repeat. 

 Tab Menu The Menu tab is a menu that 

shows commands for processing a 
document. 

 Title Bar Title Bar is the name of the 
document file that is being opened. 

 Ribbon The Ribbon is a menu located 
from the main menu commands of the 

program. 

 Slides Pane Slides Pane is the menu  

used to display slide thumbnails in 
documents. 

 Status Bar Status Bar is a menu used to 

show the status of a document. For ex-
ample the theme or number of slides 

used in the slide.  

 Notes Pane Notes Pane is a menu that 

is used as a viewer for notes on a slide. 

 Slide Area Slide Area is a menu that is 

used as a slide viewer of documents. 
View View button The View button is 
the menu that is used as a slide show 

regulator. 

 Zoom Controls Zoom Controls is a 

menu used to adjust the size of the 
slide - zoom in zoom in and zoom out 
zoom out. 

 
5) Saving Documents In saving documents, 

the steps that must be taken are as fol-
lows: 
- click the File menu 

- Click the Save sub menu 

6) Saving Documents In saving doc-

uments, the steps that must be tak-
en are as follows: 
- Click the File men 

- Click the Save sub menu 

 
 

Picture 7.Save Menu Display 

 
Then the dialog box will appear as fol-

lows: 
-fill in the name of the file to be saved 
-then click on Save 

 

Picture 8. Display Save 
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Documentation of Activities 

 

Picture 9.Preparation and Opening The 
Event 

 

Picture 10. Explanation of Making Power-

Point 
 

 
Picture 11 . Trainees listen for Explanation 

 

 
Picture 12. Photo Session with Participants. 

CONCLUSION 

 
From the results of community 

service activities carried out in PAUD 

/ IGRA Raudhatul Athfal (RA) Al-
Fariq Buntu Pane it can be concluded 

that, From the results of community 
service activities conducted at PAUD / 
IGRA Raudhatul Athfal (RA) Al-Fariq 

Buntu Pane it can be concluded that 
PAUD / IGRA Teacher Raudhatul 

Athfal (RA) Al-Fariq Buntu Pane be-
came more skilled and had the ability 
to make Microsoft PowerPoint materi-

al and making IT-based English learn-
ing videos, seen from the results of the 

training activities from the beginning 
to the end of the activity, as well as 
high enthusiasm in participating in the 

training activities provided. 
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